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MV-90 and ION technology
This technical note provides all the necessary information to configure and use a
PowerLogic™ ION™ meter with MV-90 meter data collection and processing
application. It assumes that the reader is already familiar with MV-90.
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Additional information


For meter wiring and configuration details, refer to your meter’s documentation,
available from www.schneider-electric.com.



For the latest TIM-ION and TIM_ION application notes, or for more information
on using or configuring MV-90, MVWIN, MV-COMM, MVLT, MVTCP/IP and
MVP, refer to the UTS/ITRON support group at www.itron.com.



For the latest version of ION Setup, go to www.schneider-electric.com.
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Canada V8M 2A5
Tel: 1-250-652-7100
For technical support:
Global-PMC-Tech-support@schneider-electric.com
(00) + 1 250 544 3010
Contact your local Schneider Electric sales representative
for assistance or go to
www.schneider-electric.com

ION, PowerLogic and Schneider Electric are trademarks or registered trademarks of
Schneider Electric in France, the USA and other countries. Other trademarks used are the
property of their respective owners.
Electrical equipment should be installed, operated, serviced, and maintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising
out of the use of this material.
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Hazard categories and special symbols
Read these instructions carefully and look at the equipment to become familiar with
the device before trying to install, operate, service or maintain it. The following
special messages may appear throughout this manual or on the equipment to warn
of potential hazards or to call attention to information that clarifies or simplifies a
procedure.
The addition of either symbol to a “Danger” or “Warning” safety label indicates that
an electrical hazard exists which will result in personal injury if the instructions are
not followed.
This is the safety alert symbol. It is used to alert you to potential personal injury
hazards. Obey all safety messages that follow this symbol to avoid possible injury
or death.

DANGER indicates an imminently hazardous situation which, if not avoided, will result in
death or serious injury.

WARNING indicates a potentially hazardous situation which, if not avoided, can result in
death or serious injury.

CAUTION indicates a potentially hazardous situation which, if not avoided, can result in
minor or moderate injury.

CAUTION
CAUTION used without the safety alert symbol indicates a potentially hazardous
situation which, if not avoided, can result in equipment damage.

NOTE
Provides additional information to clarify or simplify a procedure.

Please Note
Electrical equipment should be installed, operated, serviced and maintained only
by qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.
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Safety precautions

Safety precautions
Installation, wiring, testing and service must be performed in accordance with all
local and national electrical codes.

HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH
• Apply appropriate personal protective equipment (PPE) and follow safe electrical work
practices. See NFPA 70E in the USA or applicable local standards.
• This equipment must only be installed and serviced by qualified electrical personnel.
• Turn off all power supplying this device and the equipment in which it is installed before
working on the device or equipment.
• Always use a properly rated voltage sensing device to confirm that all power is off.
• Connect protective ground (earth) before turning on any power supplying this device.
• Replace all devices, doors and covers before turning on power to this equipment.
Failure to follow these instructions will result in death or serious injury.

© 2011 Schneider Electric. All rights reserved.
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Introduction
MV-90 software (developed by UTS/ITRON) is a multi-vendor translation system
that collects and analyzes data from a variety of different brands of meters. One of
the unique features of MV-90 is its ability to log information coming from several
different brands of meters, each with their own unique data formats. MV-90 can
then manipulate that data using Translation Interface Modules (TIM), without
extensive knowledge of the device of origin. Each TIM acts as a protocol translator
specific to a device type, and converts some pre-defined data from a meter to the
MV-90 database format. The TIM used for ION meters is called TIM_ION.

NOTE
Make sure that you have the latest version of the TIM_ION to help access any new features or
enhancements.
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Translation Interface Module (TIM_ION) features

Translation Interface Module (TIM_ION) features
TIM_ION is available as both an EXE and a DLL file; the DLL file is designed for
use with MVCOMM. The TIM_ION has been available since MV-90 version 3.1
SP1 (release 506 for DOS and Windows).
Some features work only with the latest release of MV-90, TIM_ION, and/or version
of ION meter firmware.
TIM_ION module offers the following features and capabilities. It reads:


anywhere from 1 to 16 data channels.



cumulative and interval data.



binary/register data.



the meter’s Event Log.



the meter’s time.



the meter’s data over serial, modem, or Ethernet communication links.

TIM_ION module also supports:


manual and auto time-set of the meter’s clock, while ensuring that auto-time
sets will not cause the meter to cross an interval boundary.



both standard and advanced ION security modes.



daisy-chain topologies.



MV-90, MVWIN, MV_COMM, MVLT, MVTCP/IP, MVP.

Terminology
For a better understanding of MV-90 and the ION meters, it is necessary to know
that:


an ION “Meter” is an MV-90 “Recorder”.



an ION “Data Recorder source” is an MV-90 “Channel”.



an ION “Integrator Rollover” is an MV-90 “Channel’s Number of Dials”.



TIM is a “Translation Interface Module”.



E-Files are “Engineering Unit” data, which is the standard MV-90 data format.

© 2011 Schneider Electric. All rights reserved.
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Configuring an ION meter for MV-90
Make sure you have up-to-date support for MV-90 features by downloading the
latest version of ION Setup from www.schneider-electric.com.
The factory template for ION meters is already configured for integration into your
MV-90 system. No meter programming is required. The factory template
information is listed in the ION Device Template Reference, available from
www.schneider-electric.com.
There are three basic steps to implement your ION meter’s factory-standard
revenue information into your MV-90 system:
1. Confirm your Load Profile (revenue log) data sources (MV-90 channels).
2. Export the Master.dat file for your meter or print out your meter’s configuration
report for manual data entry. See “Generating a Master.dat file” on page 8.
3. Import the Master.dat file into your MV-90 system to configure MV-90 channel
and source information.
4. In your MV-90 system, go to Master File Maintenance and go to the
Recorder > Comm tab. Enter the Connect Type for your meter that matches
the MV-90’s Port Connection Type.
You can now access your ION meter through your MV-90 system and download
revenue data.
This section describes how to use ION Setup to customize data logging, set
communication port protocols, and export HHF files

Data logging configuration
NOTE
For instructions on how to configure your meter’s data recorders and integrators, refer to your meter’s
documentation.

For the TIM_ION module to acquire data from an ION meter, the meter must be
configured as follows:


All the required parameters must be linked to inputs of Data Recorder 1.

NOTE
Data Recorder 1 is labeled as the Revenue Log on most ION utility meters.
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At least one input of Data Recorder 1 must be linked; the maximum number of
inputs is 16.



Data Recorder 1 recording must be triggered between 1 and 60 times per
hour.

© 2011 Schneider Electric. All rights reserved.
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Communications configuration

NOTE
Any changes to the data recorder registers will erase the data recorder contents. To avoid data loss,
download the recorder’s data before changing data recorder registers.





If integrated values are logged, set the integrator’s rollover value to 106 or 107
(IEEE 754). Refer to the ION Device Template Reference for details regarding
the factory configuration of your meter.
For MV-90 to read register/binary data, this data must be mapped as per
“Appendix 2” on page 17. This is the default for all ION meter firmware
(however, not all meter platforms support all data types).

Communications configuration
For MV-90 to communicate with an ION meter using a serial port, the meter’s serial
communication protocol must be set to ION. No communications protocol is
required if MV-90 is connected to the meter using Ethernet.

NOTE
Refer to “Appendix f: Using EtherGate and ModemGate” on page 27 for details on communicating using
EtherGate or ModemGate.

If MV-90 is to synchronize the time on an ION meter, the clock module in the meter
must be set to accept time synchronization on the port used for MV-90
communication. If MV-90 is using the Ethernet communications port, you can also
specify the time synchronization source protocol.
Refer to your meter’s user documentation for information on configuring your
meter’s clock module and communications, and the Time Synchronization and
Timekeeping technical note for detailed information on time synchronization of ION
meters.

Advanced Security
If you have enabled Advanced Security on your meter, you must consider the
following password values in your MV-90 system.

NOTE
Refer to your meter’s documentation for information on configuring Advanced Security on your meter.

For the TIM Assignments Password Length field, refer to “TIM_ION Module
assignment” on page 12.
Phone Password 1 is required only when Advanced Security has been set up in the
meter; otherwise, it is left blank. If Advanced Security is enabled, all passwords in
the Phone Password 1 field are entered as a two-digit user identity (ID) followed by
a password of up to 8 digits. There are two possible types of passwords:

© 2011 Schneider Electric. All rights reserved.
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Numeric: Password can be a numeric value, and MV-90 recognizes numeric
passwords up to 8 digits long.




For example: user ID 4 with a password of 7654321 sets the password 1
field to “047654321”.

Alphanumeric: Passwords can also be a case-sensitive word of up to 6
characters with no blanks or special characters.


For example: user ID 8 with a password of “SLeePY” sets the password 1
field to “08SLeePY”.

Generating a Master.dat file
In order to recognize and communicate with your meter, the MV-90 software needs
a Master.dat configuration file containing your meter’s information. The Master file
can be created manually in the MV-90 software, or you can use ION Setup
software (version 2.1 and later) to automatically generate the Master file. ION
Setup allows you to save the Master file to load into the MV-90 database, or you
can print a hardcopy to enter the configuration information manually.

NOTE
If ION Setup does not have the option for you to automatically create a Master file for your meter, you
can print out the meter’s configuration file and manually enter the meter data into your MV-90 system.
Refer to “Troubleshooting” on page 19 for instructions on how to generate the meter’s configuration file
from ION Setup.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for
instructions.
2. Select Reports.
3. Select MV-90 Report and click Display. The MV-90 assistant appears.
A

Matches the Customer ID in your
MV-90 system.

B

Matches the TIM Number in your
MV-90 system.

C

Select Auto Timeset to enable the
MV-90 Auto Timeset feature.

A

B
C

4. Enter or review the information that is used to identify the meter in the MV-90
database.
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Configuration for HHF files



The Customer ID and the TIM Number must match the customer ID and
TIM number in your MV-90 system.

NOTE
The Customer ID cannot contain spaces or special characters.



Auto Timeset enables the automatic timeset feature on your MV-90
recorder (refer to “Auto Timeset” on page 15).



MV-90 User allows you to select a user ID that is different than the one you
are currently using to access the meter, for meters that are using Advanced
security. If you select a different user, you are prompted for the user
password. Refer to “Supported MV-90 TIM Functions” on page 17 for more
information on users and passwords.

Enter the appropriate information in the fields and click OK. The MV-90
configuration report is generated for the meter.
5. Click Save As to save the file as an MV-90 Master file (Master.dat) or Print to
print a hardcopy.

NOTE
When saving your Master.dat file, make sure your filename is compatible with your MV-90 system.

Refer to “MV-90 database configuration” on page 12 for details on importing your
Master.dat information into your MV-90 system.

Configuration for HHF files
This section describes how to configure ION Setup if you are doing revenue log
data collection using .HHF files.

Using ION Setup
1. Open ION Setup and connect to your meter. See the ION Setup Help for
instructions.
2. If the Setup Assistant window is displayed, close it by clicking Exit.
3. Select your meter, and select Tools > Options.
4. Select the HHF tab.
5. Enter your MV-90 configuration information. For File Format, select E-File for
standard engineering unit MV-90 data.
6. Click OK to save your HHF settings.

© 2011 Schneider Electric. All rights reserved.
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Generating HHF files
You must enter your MV-90 HHF file configuration details before you can export
and save .HHF files from ION Setup to load into your MV-90 system.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for
instructions.
2. Select Reports.
3. Select Load Profile, and click Display. The Upload Log Records dialog is
displayed.
4. Select the records you want to upload and click OK. The Load Profile dialog is
displayed.
5. Select Print to print a hardcopy or select Save As to save the data. If you have
selected Save As, the Save As window appears.


Go to the Save as type drop down menu and select Hand Held Format
File (*.HHF).



Navigate to where you want to save your HHF file and click Save.

Disabling power quality event logging
You can disable Sag/Swell and Transient event logging to reduce the amount of
data logged and speed up MV-90 downloads of revenue data.

NOTE
The Sag/Swell and Transient features are not available on all meters.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for
instructions.
1. Select Logging > Event Log.
2. Select the Sag/Swell EvPriority register and click Edit.
3. Enter your meter password if prompted.
4. Set EvPriority to zero (0) to disable Sag/Swell event logging and click OK.
5. Repeat steps 3 through 4 for Transient (if present).

Enabling loss of potential event logging
Loss of potential (voltage) events can be enabled and logged in your meter’s event
log using ION Setup. This information can be used by MV-90 to provide phase loss
event reporting.
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Enabling loss of potential event logging

MV-90 phase loss event details:
MV-90 event
description

MV-90 event code

MV-90 effect
handle

Potential A inactive

A0

6064

Potential B inactive

A1

6065

Potential C inactive

A2

6066

Event priority
EvPriority value
from the meter’s
Sag/Swell module

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for
instructions.
2. Select Logging > Event Log.
3. Select PhaseLossEnable and click Edit.
4. Choose ON (to enable loss of potential logging) or OFF (to disable loss of
potential logging) from the Select PhaseLossEnable pop-up window and click
OK.

© 2011 Schneider Electric. All rights reserved.
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MV-90 database configuration
To import ION meter data into your MV-90 data management system, your MV-90
system needs the latest TIM_ION and a configuration (*.cfg) file. You also need a
Master.dat file for each ION meter.

Refer to “TIM_ION Module assignment” on page 12 for details on how to set up the
TIM_ION in your MV-90 system, refer to “Generating a Master.dat file” on page 8
to generate a Master file from ION Setup, and refer to “Appendix a: MV-90
configuration files” on page 22 for details on MV-90 configuration files.
The configuration procedure covers the following areas:


TIM_ION Module Assignment



Communications Setup



Recorder and Channel Configuration



Advanced Security



Troubleshooting

TIM_ION Module assignment
If the TIM_ION does not show up in the list of available TIMs, you must import it
into your MV-90 system and assign it a number. Relevant parameters are
described below.
1. In your MV-90 system, go to System Control > System Parameters > TIM
Assignments.
2. Right-click and select Add (or go to Edit > Add).
3. Select the first available number and assign it to TIM_ION.

NOTE
The TIM_ION number must match the TIM Number in your Master file.

Page 12 of 30
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Communications setup

TIM Assignment Parameters
Parameter
Program Name
Protocol
Manufacturer
Devices
TIM Message Level

Description
TIM_ION
ION
Schneider Electric
7700ION; this TIM will work with 7330ION, 7350ION, 7500ION, 7550ION,
7600ION, 7650ION, 7700ION, 8300ION, 8400ION, 8500ION, 8600ION,
8650ION, 8800ION.
Level 5 is recommended.

Default config file

If a default configuration file is used, it can be specified here.
Refer to “Appendix a: MV-90 configuration files” on page 22

Device ID Length

“0” (zero) is recommended as this allows a variable length. See “Device
ID Length” on page10.

Device ID Type

The TIM_ION module supports all Device ID formats: hexadecimal,
numeric or alphanumeric. Alphanumeric is recommended. Check “Device
ID Type:” on page10 for examples.

Password Length

“0” (zero) is recommended as this allows a variable length. This allows for
differences between the Phone password 1 and 2 fields.

Password type
Interval Bits

Alphanumeric.
16

Comm Parameters Tab
Parity

None

Data Bits

8

Stop bits

1

Communications setup
Refer to your MV-90 user documentation for instructions on creating and
configuring workgroups and workstations.
1. In your MV-90 system, go to System Controls > System Parameters.
2. Select Communications WS and expand to view all ports.
3. Configure each port with the appropriate data link.

NOTE
The data link must match the recorder’s communication connection type for that port. Refer to
“Appendix e: Master file settings for TCP/IP” on page 26 for communications settings for Ethernet
connected meters.

© 2011 Schneider Electric. All rights reserved.
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Recorder and Channel Configuration
Setting up the Master file for an MV-90 recorder requires that you add and configure
an ION meter (the MV-90 recorder) and its data recorder (the MV-90 channel) in
MV-90. Guidelines are presented below.

NOTE
Only the technical parameters are described. Information parameters (i.e., customer’s address) are not
described.

Import a Master File to MV-90
The easiest way to set up an MV-90 recorder is to import a Master.dat file to help
configure the technical parameters. You can generate a Master.dat file from ION
Setup; refer to“Generating a Master.dat file” on page 8.
1. Copy the Master.dat file to the MV-90 root folder.
2. Click Master File Maintenance. In the Master File Maintenance screen, go to
File > Import Master File.
3. Master.dat is the default file name.
You should see all records imported successfully.
The number of successfully imported records will equal the number of data
channels (data recorder sources) configured on your recorder (ION meter).

NOTE
MV-90 does not allow a duplicate Device ID. You can modify your meter’s Tag2 value to change its
Device ID.

Page 14 of 30
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Recorder and Channel Configuration

Manually create a Master File
To manually add and configure an ION meter as an MV-90 recorder, go to
Databases > Master File > Maintenance. You must add a customer in order to
create a new recorder and configure channels with the settings listed below.
Recorder Master file parameters
Set the Recorder parameters according to the listings below:
Parameter

Value

Details
Recorder (Recorder screen)
Although it can be set in the Master file in three different ways, the recommended method of
generating a Recorder device ID is as an alphanumeric string of variable length (“0”) based on
the TAG2 value from the Factory module of the meter.
If the TAG2 in the meter’s Factory module is blank, the TAG2 value is the serial number of the
meter.
The standard format of the meter’s serial number is xx-xxxxxxxx-xx. Hyphens must be
included.

Device ID

Meter’s Tag 2 or Serial #

The TIM_ION is also backward compatible with the legacy method of using the ION meter
communication port Unit ID formatted as either:
 a 4-digit hexadecimal equivalent of the decimal unit ID configured into your ION meter for the
appropriate communication port.
 a 5-digit decimal number, based on the decimal unit ID configured into your ION meter for the
appropriate communication port.
Example: If the unit ID of COM port 1 of your meter is 1234, the 5-digit numeric device ID is
01234 (add a leading zero to the 4-digit unit ID). The 4 digit hexadecimal equivalent device ID
is 04D2.
If the meter’s serial number or Tag2 are the Device ID, then Phone Password 2 must be the
meter’s Unit ID.
Refer to “Appendix e: Master file settings for TCP/IP” on page 26 for Ethernet Device ID values.

Call/Ret
mode

AN (Answer mode)

Must be set to AN (Answer mode). ION meters do not initiate calls in MV-90.

Interval per
hour

Minimum 1,
maximum 60

How many times per hour the meter logs data. The minimum is 1 (once per hour) and the
maximum is 60.

Active
channels

Minimum 1,
maximum 16

Should exactly match the number of data recorder sources (MV-90 channels) set up in the
meter (between 1 and 16).

More (Recorder Screen)
TIM Number

See Details

The number mapped to your TIM_ION module.

Device
follows DST

No

Must be set to No. ION meters can follow DST, but the data and event timestamps are returned
to MV-90 in GMT, and MV-90 applies the appropriate time zone and DST offsets according to
the Master file parameters.

See Details

Time difference, in minutes, between local meter time and local MV-90 time. For example, if the
MV-90 machine is in Texas, and the meter is in California, Time Zone Adjust = 120.

Yes

Must be set to Yes. The TIM_ION module can set the time in ION devices, and Auto Timeset
helps ensure that this does not cause the meter to cross an interval boundary. Refer to
“Generating a Master.dat file” on page 8 for details on how to select this option.

Time Zone
Adjust
Auto
Timeset

© 2011 Schneider Electric. All rights reserved.
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Parameter
Memory size
(Kb)
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Value

Details

0

This defines the size of the recorder RAM.
Use one of two methods to provide the required information:

TIM Config
File

Daisy Chain

 Short hand method: T=x where x is the time difference between Standard Local Time at the meter location

and GMT. It is a decimal value of 1 to 3 characters between -12 and 12.
For example, if the meter is in California, then T=-8
 Config File method: Insert the name of the TIM config file (See Appendix a: MV-90 configuration files for
more details).

See Details

It is possible to connect to ION meters so that you can read more than one meter in a single
phone call. To read daisy-chained meters, the master/slave daisy-chain flag is set to Master for
the first meter and Slave for the rest. The device ID of the master is entered into every Master
ID field in the chain. The Slave ID is the next meter to interrogate on the same call. The Slave
ID of the last meter on the daisy chain is always blank.

See Details

Comm (communications) screen
Phone
number –
MV-90

See Details

Your remote site phone number.
Refer to “Appendix e: Master file settings for TCP/IP” on page 26 for Ethernet connected
meters or “Appendix f: Using EtherGate and ModemGate” on page 27 for EtherGate and
ModemGate connected meters.

Baud Rate

See Details

As configured at your remote site. This matches the baud rate configured on your ION meter
for the appropriate communications port, and is typically set to 9600 baud.
 If the Device ID is set to the meter’s serial number or Tag2, this must be set to your meter’s actual COM port

UNIT ID, typically 5 digits in length if decimal or 4 digits in length if hexadecimal.

Phone
Password 2

 If you are communicating via Ethernet, Phone Password 2 must be set to 00100 (decimal) or 0064 (hexa-

decimal) for a direct connection to the Ethernet meter.

See Details

 If you are using ModemGate or EtherGate communications, refer to “Appendix f: Using EtherGate and

ModemGate” on page 27.
 Otherwise, this value can be left blank.

Answer
window
Days
Connect
Type

See Details

00012400 or as per ION meter setup.

“A”

‘A’ or as per ION meter setup.

See Details

If you have imported the meter’s Master.dat file from ION Setup, this should be the only value
you need to manually enter.
This parameter must match the communication port’s connection type. Refer to
“Communications setup” on page 13. For Ethernet connections, refer to “Appendix e: Master
file settings for TCP/IP” on page 26.

Channel Master File parameters
Refer to the following configuration parameters:
Parameter

Value

Details
Channel screen

Unit of
Measure

Set Number

Register
type

Page 16 of 30

Refer to Details

For the TIM_ION this is “1” for kWh readings and “3” for kVARh readings.

Refer to Details

Must be unique (or set to 0) for each channel, except for channels that are to be added
together.
Example: If channels 1 and 3 are kWh that are to be added together, then they must have the
same Set Number. All the other channels must have different Set Numbers.

Both Encoder and Visual

© 2011 Schneider Electric. All rights reserved.
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Parameter

Recorder and Channel Configuration

Value

Details
 If the channel is used for interval data, and validation is to be performed by MV-90 on this channel, the

Encoder Type has to be set as per the table in Appendix 2.

Encoder
type

 If the channel is used for a non-cumulative value such as Volts, Amps, kW, kVAR, kVA, and no register

read is required, then the Encoder type must be ‘NO’.

Refer to Details

 If the channel is used for a cumulative value (interval values computed as deltas) such as V2h, I2h, kWh,

kVARh, set the Encoder type to ‘CV’.
 If the channel is accepting the cumulative output of a digital pulse, set the Encoder type to “CV”.
 If cumulative values are to be read by MV-90 as is, set the Encoder Type to ‘NO’.

Number of
Dials

Refer to Details

This is the number of digits where the rollover of a cumulative value occurs.
For example: If the kWh Integrator module of your ION device is set to rollover at 107 (or
10,000,000) then the Number of Dials for the corresponding channel is 7 (seven).

Power Flow

Refer to Details

Delivered for DEL or Import data, Received for REC or Export data

Multipliers and Readings screen
PT/CT Ratio

Refer to Details

1 for V2H and I2H channels, 0 for all other channels.

Meter
Multiplier

Refer to Details

1 if the meter is set up to return primary data, or the (PT ratio) * (CT ratio) if the meter is set up
to return secondary data. Refer to Note.

Pulse
Multiplier

Refer to Details

In order that recorder data successfully validates against meter data, this field must have the
same value as the Meter Multiplier. Refer to Note.

NOTE
Meter multiplier and pulse multiplier values are configured for MV-90 standard checking based on
whether the recorder (meter) is recording primary or secondary data.
For standard (E-File) data format, the meter multiplier and the pulse multiplier must be the same value.

Supported MV-90 TIM Functions
Initialize Recorder
The “initialize recorder” function sets the time in the meter, checks where to allow
load profile to start and sets the MV-90 database to accept the data.
All Read
This function reads all the load profile data available from the meter. Use the All
Read function for the first read of meter data.
Partial Read
This function reads the meter load profile data from the last read date to the most
current interval. If the last date read is before the initialization date, the first record
in the load profile, or in the incorrect format, then the TIM automatically converts
the partial read to ALL READ, and reads all data available after the initialization
date.

NOTE
Partial/Full reads should be done at least two intervals apart or two intervals after an initialization in
order to help correctly process cumulative values.
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Setting Passwords
You cannot set the user 1 (usually the highest-level user) password at the same
time as additional users. This process works best when user 1 (USER01) is
pre-established in the Master file. You can then set the passwords for other
advanced security users established in the meter setup.
Password 1 may be set if the meter is using the Advanced Security module.
Password 1 will consist of a two-digit user identifier (00-16) followed by up to 6
alphanumeric characters or up to 8 numeric digits. The password change function
and initialization function has the ability to set any ION user's password (in
TIM_ION releases after 11/19/02).
If the user identifier (ID) matches the user ID of the password 1 field, the Master file
will be updated. The Password Change and Initialize function requests will write the
Password if the WRITEPW keyword exists in the TIM configuration file or the
password is entered in the New Password Field on the Manual Remote
Interrogation screen.
The Password 1 field in the MV-90 Master File will be updated if the new
password's user ID matches the user ID of the password in the Master file. The
password 1 field will also be updated if the password 1 field is currently blank and
the new password is for user 1.
If password 1 is blank and it is updated with user 1’s password, the DEFAULTPW
keyword in the configuration file will no longer specify the default password
because the password 1 field is no longer blank. The user ID and password
(provided as the default password in the TIM configuration file or entered in the
Master File) must have the appropriate security to update the password
parameters.
Default Advanced Meter Password DEFAULTPW=UUPPPPP (supported after version
11/19/02)

The value UU indicates the user ID and PPPPP represents the password for that
user ID. The default password is used if no password is present in the Password 1
field in the MV-90 Master File. The user ID and password (setup as the default
password in the TIM Config file or entered in the Master File) must have the
appropriate security to update the password parameters.
Write New Password to Meter WRITEPW =UUPPPPPP (supported after version 11/19/
02)

If the meter's password is set or the meter is initialized, new-password is the
password that will be changed in the meter (in the IONTM password format of
UUPPPPP). Any user ID can be changed, provided that the password defined in
the Password 1 field or the default password (if no Password 1 defined) has the
proper permissions. There may be multiple (up to 15) WRITEPW keywords used
within a single configuration file to set the password for multiple user ID's on a
single change password or initialization function request. If the new-password has
the same User ID as the password defined in the Password 1 field in the MV-90
Master File, it will automatically be updated to the new password. If the Password
1 field is blank, it will update the field with the new-password if the user ID in the
new-password is user ID 1 (01).
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Data Retrieval

Set Time
This function adjusts the meter time using the current MV-90 system time. The time
stored in an ION meter is in the Universal Time Coordinate (UTC/ GMT) by default.
In order to calculate the “time to set”, the system time is adjusted using the time
zone offset in the Master file and the T= parameter from the configuration (CFG)
file. The time zone offset in the ION meter must match the T= value. Refer to
“Appendix a: MV-90 configuration files” on page 22 for more information on
configuration file set up.
Update DST Times
Although ION meters can display local time with or without DST applied, this
function is not needed and not used by the TIM_ION module.

Data Retrieval
Since intervals are timestamped by the ION meter, two special cases are handled
by TIM_ION:


Gaps in intervals are filled with zero values and marked as ‘Missing Data’ in
the interval status.



Overlaps are kept and marked as ‘Time Reset’ in the interval status.

TIP
Perform a data retrieval step to verify your recorder’s configuration.

Troubleshooting
MV-90 Debug Log
The MV-90 system can be configured to generate debug files. The TIM (meter
communications) file ‘*.rd’ contains valuable information such as:


Date of the TIM_ION



Time zone configuration method used (i.e. T=-8; ION.CFG)



Device ID in hexadecimal format



Successful response to Read request



MV-90 error messages

NOTE
Refer to the MV-90 system’s online help for information on the TIM (meter communication) debug file.
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How to Export a Master File from MV-90
1. Go to Databases > Master File.
2. Select Export Master File.
3. Change the default Master.dat file name if desired.
The number of successfully exported records will equal the number of data
channels configured within MV-90. A file with the specified filename is created
within the MV90/Master folder.

Master File Report
1. Go to Databases > Master File > List Master File.
2. Choose the default options of List Combined Files and By ID.
3. Enter the Customer ID and run the report.

TIP
To view a Master file, open it with Microsoft Notepad.

ION Setup
It is also possible to use ION Setup as a troubleshooting tool for MV-90 by using
the “Meter Configuration Report” available in the Setup Assistant. To view/print a
meter configuration report in ION Setup:
1. Open ION Setup in single device mode (this helps ensure ION Setup connects
to the appropriate device).
2. Once connected to the meter, open Setup Assistant and click Reports.
3. Click Meter Configuration, then click Display.
ION Setup generates a meter configuration report. The report contains information
useful as a troubleshooting tool for the MV-90.
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Example of Meter/Channel Master File Entries
The following is a sample of a MV-90 Master File configuration for an ION8600
meter with a factory default configuration. These values may vary depending on
your meter type and configuration.

NOTE
You must first perform a TIM assignment by creating an entry for the TIM_ION.

Master File:
Recorder Master
File Maintenance

Values

Intervals per hour/
daily

4

Call/retrieval mode

AN

TIM number
Device ID

Created within TIM assignments
Meter Serial Number

Master File:
Remote
Interrogation
BAUD rate
Auto timeset
TIM config file

Values

9600
Y (if MV-90 is used to time sync the meter)
T= -8 (time zone offset or name of ‘<filename>.cfg’)*

Channel Master
FIle Maintenance

Values

Unit of Measure
code

1=kWh; 3=kVARh

Meter multiplier

1 (if primary units); CT * PT (if secondary units)

Pulse multiplier

1 (if primary units); CT * PT (if secondary units)

Register type
Number of dials
Encoder type
Enter optional data

B (both encoder and visual)
7 (cumulative integrator rollover setting)
kWh del = 1; kWh rec = 2; kVARh del = 5; kVARh rec = 6
Y (power flow direction: D=delivered; R=received)

* Refer to “Appendix a: MV-90 configuration files” on page 22.
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Appendix a: MV-90 configuration files
The following points give additional information about MV-90 configuration files:

NOTE
Quotation marks (“”) in the descriptions are for clarity and are not part of the parameters.



“T=xx” in the Master file’s “Config file” field is sufficient for MV-90 to read ION
meters and an actual config file is NOT required.



Configuration files can have any legal DOS name, and usually have a .CFG
extension.



The default location is the main MV-90 directory for DOS RI_IMP and the
Master directory for WINDOWS RI_COMM/MV_COMM; however, any valid
path name may be used.



Comments may be added by placing an exclamation mark, ‘!’, in the first
column of any line.



Each parameter must be on a separate line and beginning in column 1.
Spaces are not allowed.



The configuration file can be created and/or edited with any text editor, such as
Notepad.

Configuration file for MV-90
The following parameters are allowed in an MV-90 config file; only “T=n” is required
for standard (E-File) data.

Parameter
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Description

T=n

See “Example of Meter/Channel Master File Entries” on page 21.

R=n

Should be equal to the “Data Recorder 1 depth” set in the meter.* (1
to 4 digits: maximum FFFF) This parameter is a hexadecimal number
of history log records setup in the meter.

RDIG=n

Number of digits before a cumulative channel rollover occurs. It is a
decimal number (if rollover is set at 1 million then RDIG=6).

ROF=n

Maximum negative progression of a cumulative channel in an interval
before it is assumed a rollover has occurred. Value is expressed as a
percentage of the rollover value and entered as a whole number
(50% entered as ‘50’ not ‘0.5’).

RECBUF=n (supported
after 11/01/99)

Set to ‘15’ to minimize connection time with the meter. Set to ‘1’ for
remote sites with limited communications. This parameter defines an
integer number between 1 and 15 that represents the number of
records requested in each read command.

EVENT_CUTOFF=n
(supported after 11/01/99)

Defaults to 0 (zero) to read all events. Set above 255 if no events are
to be logged. This parameter defines which meter events will be
imported in MV-90. Only meter events with a priority equal to or
greater than EVENT_CUTOFF are recorded in MV-90’s event log.

© 2011 Schneider Electric. All rights reserved.

MV-90 and ION technology

Config file for MVLT, MVP

Parameter

Description

TO=n
(supported after 2/28/00)

1200 (12 seconds) is an adequate value. Allowed values are 100 12000. This parameter defines the number of hundredths of seconds
to wait for the meter to return the first character of its response.

ITO=n
(supported after 2/28/00)

1000 (10 seconds) is an adequate value. This parameter defines the
inter-character timeout. It is the number of hundredths of seconds to
wait for each byte of data from the meter after the previous byte has
been received.

* R is no longer required (11/09/99). The recorder depth is read from the meter, but this value may be
included to override the meter settings. This is useful when you do not want to read all of the sources
(MV-90 channels) of Data Recorder 1.

Config file for MVLT, MVP
The following are the parameters allowed in an MVLT or MVP config file; DEVID,
T, CHAN, INPHR, CV are required.

Parameter

Description

DEVID=n

Device ID of the meter (see “Example of Meter/Channel Master File
Entries” on page 21) and must be the first entry of each configuration
block. The configuration for this device continues until the next DEVID=
or the end of the CFG file.

UNIT=XXXX or
UNIT=ddddd

Must be specified if the device ID is either the meter’s serial number or
Tag 2. Refer to “Example of Meter/Channel Master File Entries” on
page 21.

R=n

See “Configuration file for MV-90” on page 22.

T=n

See “Configuration file for MV-90” on page 22.

CHAN=n

Number of channels in the meter; It has to match the number of inputs to
Data Recorder 1 in this meter.

INPHR=n

Number of intervals per hour recorded by the meter.

CV=n”:

Channel number of a channel that records a cumulative value. There
must be an entry for each channel that stores cumulative data.

RDIG=n

See “Configuration file for MV-90” on page 22.

ROF=n

See “Configuration file for MV-90” on page 22.

RECBUF=n

See “Configuration file for MV-90” on page 22.

EVENT_CUTOFF=n

See “Configuration file for MV-90” on page 22.

Example of MVLT configuration file:
DEVID=01234
CHAN=4
INPHR=4
T=-5
RECBUF=15
EVENT_CUTOFF=65000
CV=1
CV=3
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Appendix b: Register map for data validation
MV-90
encoder
type

Data type

ION
Integrator
module #

ION
handle
number
N/A

‘CV’

Value Recorded on last
interval

N/A

‘NO’

Interval data only; No
Register read

N/A

'01'

KWh imp del

INT 1

'02'

KWh exp rec

'03'

MV-90
encoder
type

Data type

ION
Integrator
module #

ION
handle
number

'55'

kwh Q1

INT 55

#5FB7

'56'

kwh Q2

INT 56

#5FB8

#58B0

'57'

kwh Q3

INT 57

#5FB9

INT 2

#58B1

'58'

kwh Q4

INT 58

#5FBA

KWh tot (del + rec)

INT 3

#58B2

'59'

kQh Del D

INT 59

#5FBB

'04'

Kwh Net (del rec)

INT 4

#58B3

'60'

kQh rec D

INT 60

#5FBC

'05'

kvarh imp del

INT 5

#58B4

'61'

kwh del A current season

INT 61

#5FBD

'06'

kvarh exp rec

INT 6

#58B5

'62'

kwh rec A current season

INT 62

#5FBE

'07'

kvarh tot del + rec

INT 7

#58B6

'63'

kwh del B current season

INT 63

#5FBF

'08'

kvarh net del – rec

INT 8

#58B7

'64'

kwh rec B current season

INT 64

#5FC0

'09'

kvah imp del

INT 9

#58B8

'65'

kwh del C current season

INT 65

#5FC1

'10'

kvah exp rec

INT 10

#58B9

'66'

kwh rec C current season

INT 66

#5FC2

'17'

kvarh Q1

INT 17

#5C3B

'67'

kwh del D current season

INT 67

#5FC3

'18'

kvarh Q2

INT 18

#5C3C

'68'

kwh rec D current season

INT 68

#5FC4

'19'

kvarh Q3

INT 19

#5C3D

'69'

kvar del A current season

INT 69

#5FC5

'20'

kvarh Q4

INT 20

#5C3E

'70'

kvar rec A current season

INT 70

#5FC6

'21'

kvah Q1

INT 21

#5C3F

'71'

kvar del B current season

INT 71

#5FC7

'22'

kvah Q2

INT 22

#5C40

'72'

kvar rec B current season

INT 72

#5FC8

'23'

kvah Q3

INT 23

#5C41

'73'

kvar del C current season

INT 73

#5FC9

'24'

Kvah Q4

INT 24

#5C42

'74'

kvar rec C current season

INT 74

#5FCA

'33'

kvah tot del + rec

INT 33

#5FA1

'75'

kvar del D current season

INT 75

#5FCB

'34'

kvah net del – rec

INT 34

#5FA2

'76'

kvar rec D current season

INT 76

#5FCC

'47'

kQh Del

INT 47

#5FAF

'77'

kvah del A current season

INT 77

#5FCD

'48'

kQh rec

INT 48

#5FB0

'78'

kvah rec A current season

INT 78

#5FCE

'49'

kQh Del A

INT 49

#5FB1

'79'

kvah del B current season

INT 79

#5FCF

'50'

kQh rec A

INT 50

#5FB2

'80'

kvah rec B current season

INT 80

#5FD0

'51'

kQh Del B

INT 51

#5FB3

'81'

kvah del C current season

INT 81

#5FD1

'52'

kQh rec B

INT 52

#5FB4

'82'

kvah rec C current
season

INT 82

#5FD2

'53'

kQh Del C

INT 53

#5FB5

'83'

kvah del D current season

INT 83

#5FD3

'54'

kQh rec C

INT 54

#5FB6

'84'

kvah rec D current
season

INT 84

#5FD4
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Appendix c: Validation setup
When collecting encoded meter readings, there are several types of validation that
may be checked in the validation process. These depend on the values in SYSTEM
PARAMETERS; VALIDATION; TOLERANCE TYPE. See the MV-90 Reference
Guide and MV-90 help-files (especially MV-90 DOS help).

Tolerance
Type

Description

M

Compares the difference as a percentage of the meter multiplier. This is
intended to allow comparison of the difference between the sum of the
intervals and the difference of the last and current meter reads as a
percentage of a dial rotation.

P

Percentage comparison of the difference of the meter reads with the total
meter energy reading. As the reading goes up, a set percentage of the
reading can be “error”.

Q

Difference between the interval sum and the meter reads is expressed as
a percentage of an average of the past 30 days of data. This allows the
“error” to be larger when the readings are large and smaller when the
readings are small.

D

Checks P, if P fails, checks M.

E

Checks P, if P fails, checks Q.

N

None.

Since ION meters typically have a meter multiplier of 1.0, the tolerance percentage
either needs to be large, or based on the P or Q methods. Since this setting is in
the system parameters, it affects all validations for the workstation.
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Appendix e: Master file settings for TCP/IP
Only customers who have the additional MV-TCP can use TCP/IP communications
to do MV-90 interrogations of ION meters. See your ITRON EIS sales
representative if you need to license the MV-TCP package option.
When using the built-in TCP/IP port on the ION meter, the following settings are
used:
Parameter
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Description

MV-90 Phone Number

xxx.xxx.xxx.xxx/7700 (IP address, slash, port 7700)

Phone Password 2

Must be the same as the unit ID. For Ethernet meters, the unit ID is 0064h
or 00100 decimal.

Connect Type

Must match port Connection Type (TCPIP). Refer to “Communications
configuration” on page 7.
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Appendix f: Using EtherGate and ModemGate
You can import data from serial ION devices into MV-90 using the EtherGate or
ModemGate communications configuration. Refer to your meter documentation
and The ION meter as a ModemGate or The ION meter as an Ethernet gateway
technical notes for more information.
Since MV-90 can only communicate with one meter on an RS-485 bus at a time,
meters on an RS-485 bus should be connected or pooled together. By using
pooling, you can also help minimize simultaneous communication retry attempts.
EtherGate and ModemGate only support one single connection. Make sure that no
other systems are attempting to connect to your EtherGate or ModemGate serial
devices and conflicting with MV-90.

NOTE
Create and verify your EtherGate and ModemGate sites in ION Setup or ION Enterprise software before
configuration in MV-90.

ModemGate settings are as follows:
Parameter

Description

MV-90 Phone Number

Your remote site phone number

Phone Password 2

The Unit ID of the serial meter’s communication port

Connect Type

The port Connection Type (MODEM). Refer to “Communications
configuration” on page 7.

EtherGate settings are as follows:
Parameter
MV-90 Phone Number

Description
 xxx.xxx.xxx.xxx/7801 (IP address and COM1 EtherGate)
 xxx.xxx.xxx.xxx/7802 (IP address and COM2/COM4 EtherGate)

Phone Password 2

The Unit ID of the serial meter’s communication port

Connect Type

The port Connection Type (TCPIP). Refer to “Communications
configuration” on page 7.

NOTE
The ION7700 meter can EtherGate simultaneously to COM2 and COM3 using port 7800.

Use of the TCP/IP protocol with ION meters may be subject to any limitations on
ITRON’s TCP package.
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ModemGate/EtherGate example
In this example, the serial meter is connected via RS-485 (COM1) to the RS-485
(COM1) port on the gateway meter.
Serial meter

Gateway meter

RS485

Ethernet or
Telephone line

The serial meter’s COM1 port settings are:
Comm mode

RS485

Protocol

ION

Baud

9600

Unit ID

124

NOTE
Refer to your meter’s documentation or the Troubleshooting serial communications technical note for
more information on configuring serial communications for ION meters.

The gateway meter’s serial COM1 port settings are:
Comm mode
Protocol

RS485
 ModemGate
 EtherGate

Baud

9600

Unit ID

100

NOTE
There are no gateway-specific settings on the modem or Ethernet communications ports of the gateway
meter.

The serial meter’s MV-90 Master file must be configured as follows to access to the
serial meter through the gateway meter via MV-90:
Phone # - MV-90
Unit Address
Connect Type

 remote site phone number (ModemGate)
 xxx.xx.xx.xxx/7801 (EtherGate)

124
 MODEM (Modem port connection type)
 TCPIP (Ethernet port connection type)

All other serial meter MV-90 Master file settings are based on the serial meter’s
configuration.
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Appendix g: Using MVP with TIM_ION
The following parameters are allowed when using MVP meter data management
and billing software with TIM_ION:
Parameter

Description

MVP.EXE

Dated after 7/01/00*

TIM_ION.EXE

Dated after 7/01/00*. TIM_ION can only be run on MVP with routs or by
using a configuration file. The configuration file must be stored in the MVP
directory on the handheld PC.

Message Level

Set to 5.

* Both the MVP.EXE & TIM_ION.EXE should be dated after 7/01/00. Because of the size of
TIM_ION.EXE, it is recommended that the number of TIMs loaded on the handheld be kept to a
minimum. Also, since TIM_ION can generate large debug files, it is recommended that the message
level be kept to a low value. Message Level 5 generates a smaller debug file than message level 6,
and overwrites the current debug.rd/.wr file.

With MVP and the Config file method, you can read the meter using a user ID,
password, and one of the following must be provided:

Parameter

Description

Device ID

Must match exactly the DEVID=line in the configuration file, and must
match the unique device ID in the MV-90 Master file. Device ID may be
filled in at the MVP ID prompt - this ID must match whatever is being used
in the MV-90 Master file as a device ID.

UNIT ID

Must match a UNIT=line in the .CFG file. The TIM reads the TAG2 and
Serial number fields from the meter to determine the proper device ID.
The Unit ID is entered on the MVP screen field for Password2. This must
match what MV-90 uses in the password2 field.

NOTE
ION meters allow separate Unit IDs for each communications port on the meter. Each port used to
collect data on a meter must use the same Unit ID to be recognized as the same device by MV-90. This
must uniquely identify the meter in the MV-90 database.
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